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Keynote: Getting Uncomfortable 

Devon Brooks 

Introduction: Most of us would like to think we’re up for anything. The fact is, the fear of 

discomfort is one of the greatest barriers to entry as it relates to developing as a 

communicator. Because, ultimately, what we are going to talk about, we must be prepared to 

feel. Without learning how to face these hard truths, we cannot elevate our relationships, 

advance our careers, achieve our dreams, or help ourselves. How you share, and how you 

listen, influences the outcome of everything you do. How would your life change if you woke up 

every day, committed to communicating virtuously? It ain’t always gonna be comfy. 

Be intentional about discomfort. 

Energy check-ins: Internal. When faced with challenges, the ability to look inwards and take 

inventory of what is influencing me helps me show up in a way that I desire as a leader. 

Recognize where you are at on a scale so you can see a difference and assess what you can do 

to fill the gaps. 

What are you at on a scale of 1 to 5? What can you do to get to a 5, if you are not there? 

You may have been in a situation where you are a 1 and you need to be a 5 because the person 

you are supporting is a 1. How do you nourish yourself to make sure that you can show up as a 

5 when you need to? 

The best leaders show up and role model their strength and fragility for everyone to see.  

Speak the truth, even if your voice shakes. 

Choose momentum.  

Take inventory of how trauma can influence you in all facets of your life. 

If you are not an activist, you are a bystander. If you don’t stand up, you are sitting down.  

All of these things are going to happen and you are going to have to figure out how to be a 5. 

The gift of trauma is perspective. 

If we can role model this, what is possible? One seed can infiltrate. That’s how culture begins. It 

grows.  

There’s a gentle difference between TMI and full disclosure. 

TMI: Verbal diarrhea  

Full Disclosure: Naming your feelings, taking inventory of what is shaping you, give an 

explanation, information about what is influencing you, let people know how they can support 

you. ‘This is what is influencing me, this is how it is showing up, have you seen this… I really 



want to keep working, and if you are interested in how you can support me, this is what I need.’ 

You may be surprised who will come to bat for you if you give them the information.  

Activity: Name three areas, themes, or topics that are difficult for you. 

Clarity means naming your intention. 

Your passion can become a roadblock.  

It doesn’t get better, it just gets different. 

It can show up as a roadblock because you don’t know how to disclose that when it matters.  

Idleness can be terrifying. Stillness can be uncomfortable. 

Name things that you would like someone to feel at the end of a dialogue. Tell people how you 

would like to leave them feeling. Ask them to tell you if they are feeling the opposite you can 

say it in a different way that may help it resonate more. 

Defy the status quo. 

Shift thinking. Shift approaches. Role modelling through action. Behaviour that is uncommon. 

You can’t always choose your challenges, but you choose how to respond. 

@devsdevelopment 

Inclusive and Exclusive Language 

Teddy Syrette 

The pen is mightier than the sword. 

We don’t always have the skill to deal with it, but we are leaders. Bring in another helper, 

another leader.  

Understand your privilege. Use your privilege as a platform to help other people.  

When you do not know how to connect with someone, talk about food.  

People don’t know how to understand. How to respect. How to ask those questions. We can 

change what we don’t know by asking questions. Try to increase your capacity for 

understanding.  

Ombudsperson 101 

Jean-Frédéric Hübsch & Sue Haslam 

Ombudsman: An official appointed to investigate individuals’ complaints against 

maladministration, especially that of public authorities. Citizen’s representative. Independent 

of the government. Works to resolve issues.  

The Ombudsman is an independent officer of the Legislature who investigates complaints from 

the public about Ontario government services, recommending improvements for governance 

and resolving individual issues. 



Who they Oversee: 

- 500+ provincial government ministries, agencies, boards, commissions, corporations, 

and tribunals (including colleges of applied arts and technology) 

- 82 school board and authorities 

- 21 universities receiving regular direct operating funding from the government 

- 444 municipalities 

Additional Information: https://ombudsman.on.ca/Home.aspx  

Governed by The Ombudsman Act 

Last resort. 

Discretion not to investigate. 

Require disclosure of information and documents. 

The office does not have the power to give orders or directives.  

Fact-based assessments leading to recommendations.  

Investigations are very thorough.  

Greatest Power: Moral Suasion 

Focus on Administrative Conduct 

Complaint Resolution 

“fairness lawyers” 

Confidentiality: process is private; information received from complainants and organizations 

are kept in confidence. 

More than 51% of complaints resolved within one week. 

Complaint Handling: 

- Early Resolution Team (40 staff with legal background) 

Individual complaints, quickly resolved 

- Investigations 

Individual complaints, more difficult issues 

- Special Ombudsman Response Team  

Systemic investigations 

- Legal 

Open meetings, advice and support 

How Early Resolution Works: 

- Contact the individual 

- Conduct a detailed intake 

- Intake calls recorded 

https://ombudsman.on.ca/Home.aspx


- Discretion not to investigate 

- Contact organizations 

- Team-based approach 

Following Issues: 

- Track trends 

- Flag certain complaints 

- Research 

- Internal wiki of resources 

- Case assessments 

- Transfers to Investigations or SORT 

Escalations: 

- Escalate up the hierarchy 

- Few cases move to formal investigation 

Special Ombudsman Response Team (SORT): 

- Serious, high-profile, systemic issues affecting large numbers of people 

- Monitor complaint trends or patterns 

- Be aware of public debate and discussion, in the legislature or media 

- Look beyond individual complaints to the underlying causes 

Investigations: 

- ‘Generalist’ investigators working on complex or multi-party cases 

Complaints to the Ombudsman 2015-2016 

St. Lawrence College – 3 

Types of Complaints: 

Tuition Fees 21% 

Grades & Academics 25% 

Enrollment 11% 

Course Quality/Content 8% 

Accommodations 7% 

Bully/Harassment 8% 

Other 20% 

What would you need if a student wanted to file a complaint? 

Document the process. Emails, notes. Avoid the he said/she said.  

What you should know: 



- We are an office of last resort 

- We look at procedure and administration 

- We don’t act as advocates 

- Most complaints are resolved quickly 

- We can help with issues ranging from OSAP to admissions 

Questions? Contact 1-800-263-1830 or email info@ombudsman.on.ca. 

Financial Literacy and Budgeting 

Tim Sothern 

Statement of Operations: Shows income and expenses for a period of time. Revenues and 

expenses are shown at gross amount.  

What to look for: 

- Differences from your expectation 

- Comparison to budget 

- Comparison to prior year 

- Why is there a surplus or a deficit? 

- Are any items a one-time or non-reoccurring amount? 

Amortization: Non-cash expense. Cost of asset brought into expenses over useful life of capital 

asset. Estimate based on accounting and not actual cost. 

When businesses amortize expenses, it helps tie the cost of the asset with the revenues it 

generates. For example, if a company buys a ream of paper, it writes off the cost in the year of 

purchase and generally uses all the paper the same year. Conversely, with a large asset, the 

business reaps the rewards of the expense for years, so it writes off the expense incrementally 

over several years. 

To illustrate the amortization of an intangible asset, imagine XYZ Biotech spends $30 million 

dollars on a patent with a useful life of 15 years. Theoretically, to account for the expense over 

a 15-year period, XYZ Biotech records $2 million each year as an amortization expense. 

Balance Sheet: Snapshot in time of assets, liabilities, and equity (Statement of Financial 

Position). 

Accounts Receivable: Accounts receivable is a legally enforceable claim for payment held by a 

business for goods supplied and/or services rendered that customers/clients have ordered but 

not paid for. These are generally in the form of invoices raised by a business and delivered to 

the customer for payment within an agreed time frame. Accounts receivable is shown in a 

balance sheet as an asset. 

mailto:info@ombudsman.on.ca
http://www.investopedia.com/terms/u/usefullife.asp


Deferred Revenue: Deferred revenue is not yet revenue. It is an amount that was received by a 

company in advance of earning it. The amount unearned (and therefore deferred) as of the 

date of the financial statements should be reported as a liability. 

Balance Sheet: A – L = FB 

Asset: what you own 

Liabilities: what you owe 

Fund balances: net worth of a fund; assets after liabilities 

What to look for: 

- How do total assets compare to total liabilities? 

- Are there sufficient current assets to pay for liabilities? (solvency) 

- How much has been set aside for the future? 

- Are we spending restricted funding? 

- Does the organization have the ability to respond or adapt to changes? 

Net Assets: Breaks down the information into general categories. Internally restrictied, 

externally restricted, unresstricted.  

Statement of Changes in Net Assets: Shows changes in the equity over a period of time.  

Unrestricted: Past earnings held within the organization to be used in the future. 

Internal transfers: Typical use of general funds to buy capital assets. 

Statement of Cash Flows: What happened to the cash. Reconciles net incomes or loss to 

changes in cash. 

What to look for: 

- Will answer questions on where you spent your earnings 

- Is the organization increasing cash from general operations? 

How much cash should we hold? 

Months of cash = Total cash ÷ (total operating expenses – amortization)/12 

Investment Policy 

- What to do with excess cash? 

- What type of investments are allowed? 

- How much is reasonable? 

Notes to the Financial Statements 

- Explains policies 

- Breaks down some items further 

http://www.accountingcoach.com/blog/what-are-revenues
http://www.accountingcoach.com/blog/what-is-a-financial-statement
http://www.accountingcoach.com/blog/what-is-a-liability


- Usually explains items on the balance sheet 

- Notes also include mandatory disclosures according to accounting standards 

Other Financial Info 

- Consider alternative ways to review 

- Comparison to budget 

Understanding Budgets: THEY ARE ALWAYS WRONG! 

Budgets are a key tool for Board members to monitor operations. 

Review Budgets for Variances 

Negative Variances: Management should have a plan to address how they are getting back on 

track. 

Positive Variances: Does not always mean good performance. 

Creating an Accessible Campus 

Steve Murphy 

People who are old do not want to be seen as disabled, and people who are disabled do not 

want to be seen as old. 

Legislated Responsibilities 

Human Rights Code – Duty to Accommodate 

Ontarians with Disabilities Act 2001 (ODA) 

Purpose: To improve opportunities for people with disabilities by identifying and removing 

barriers to full participations 

- Applies to broader public sectors only 

- Annual Accessibility Planning Process 

- Creation of Accessibility Directorate of Ontario 

- Accessibility Advisory Committee required for municipalities over 10,000 

 No standards and limited enforcement 

Accessibility for Ontarians with Disabilities Act, 2005 

Purpose: 

- To achieve fully accessible Ontario by 2025 

- Develop accessibility standards 

- Enforce the standards 

- Applies to public, broader public, and private sectors 

AODA Standards: 



- Customer Service      Customer Service Standard 

- Employment 

- Information and Communication 

- Transportation (buses) 

- Built Environment (streets, sidewalks, washrooms, etc.) 

Customer Service Standard – required to provide requested services such as interpreters. 

Required to post admission fees for support persons of people with disabilities.  

What is Accessible Customer Service? 

- Flexible service that meets the needs of an individual customer 

- Putting the person first 

- Understanding that some methods of service may not work for all people.  

Four Principles of Customer Service: 

- Dignity 

- Independence 

- Integration 

- Equal Opportunity 

Assistive Devices 

Service Animals 

Support Person 

JUST ASK! 

The Ramp Project: Engage various community partners in a collaborative effort to increase 

awareness. Approach private sector retail operators and offer to build portable ramps to allow 

increased opportunity for those with disabilities to access their stores.  

Transitioning Advocacy Priorities 

Ciara Byrne 

Advocacy Training Program 

Coming to CSA Conferences 

Level 1: Advocacy 101 – Building an Advocacy Strategy (May 2017) 

Level 2: Advocacy in Action (November 2017) 

Level 3: Transitioning Advocacy Priorities (February 2018) 

Advocacy Priority 

Background 

Timeline 

Current Status 



Suggested Next Steps 

Additional Information 

Step 1: Analyze Current Advocacy Priorities 

- things you have completed 

- things that need to continue next year 

Improve awareness of mental health challenges and services to support students 

Increase the available hours for the walk-in medical clinic 

Safeguard Athletics from the school and ensure that SAC continues to oversee the budget 

Step 2: Provide Background 

- why this was made a priority; what is the problem 

- what was the board’s idea of success for this goal? 

The college wanted to take over the Athletic budget and eliminate the student input and 

overseeing of the budget. We believe it is important for SAC to have input and to ensure 

student representation in the creation of the Athletic budget.  

Success is continuing to deny the college control of the athletics budget and ensuring the SAC 

has contributions and final say over the budget.  

Step 3: Create a Timeline 

- what work has to be done to achieve this goal? 

- month-by-month recount of activities and steps taken towards goal 

- define important community or college timelines  

Brief incoming executives on proposals by the school regarding the Athletics budget and the 

reasons why they were proposing this change.  

Provide information and rationale regarding our decision to retain the budget and the 

documents signed to support our decision. 

Update them on changes to the budget and Athletics that have been made/are coming. 

Timelines: College Budget in November (they will propose it again before then) 

September – initial proposal to change ownership of the budget 

October – meetings to explain why, benefits, financial struggles with Athletics; attempt to 

increase the Athletics fee denied 

November – decision to decline the change of ownership  

December – creation of Athletics Review Committee with 8 college and SAC stakeholders to 

restructure Athletics to meet budget constraints 

January – background information presented at Committee meetings 

Step 4: Current Status of Goal 

- how close is the goal to being completed? 

- is the goal being reviewed? 



- is research being done on the topic? 

- have you started advocating for the goal? 

The goal is ongoing, and will be an ongoing battle with the college, as they will likely propose 

this change to every board in hopes that one will eventually approve it. 

The Athletics budget is being reviewed by the Athletics Review Committee.  

Research is being presented at Athletics Committee meetings to understand all perspectives, 

histories, comparisons to other colleges in the province, stats on varsity, costs, etc.  

We consistently advocate in these meetings to represent the best interests of the students and 

the money they contribute to Athletics. 

Step 5: Suggested Next Steps 

- Provide a list of suggested action items with the rationale behind it 

- who should the board reach out to for more information? 

- What meetings should be set up with decision makers? 

- should the priority go back to the drawing board? 

Reading the meeting minutes from the Athletic Review Committee. 

Talk to Annette, Marg, Doug regarding Athletics; what has been done, and why 

Attend the Athletic Review Committee (2 executives), have discussions with the Board, 

contribute to the conversation and meticulously review and provide input on the creation and 

revision of the Athletic budget before the AGM. 

Step 6: Additional Information 

- provide any additional comments for the next board 

- are there objections from the college to look out for 

Communicating Transition Documents: 

- Transition training session 

- Transition binder 

- Company dropbox 

- Strategic Framework appendix 

Strategic Mandate Agreements 

John Horrox 

Multi-Year Accountability Agreements (2009) replaced by Strategic Mandate Agreements 

(2014). 

Agreement between college and government for the college to report standardized information 

every year.  

MYAA: 

- Enrolment 



- Underrepresented students 

- Student access aguarantee 

- Credit transfer 

- Class size 

- eLearning 

- International initiatives 

- Supply chain compliance 

- Work integrated learning 

- Student satisfaction 

- Graduation rate 

- Graduate employment rate 

- Student retention 

- Quality of learning environment 

Four differences: 

- Differentiation 

- System wide and college metrics 

- New data categories & removed categories 

- Will be linked to funding formula 

Differentiation: Comparative advantage; individual or college who is the best at doing 

something should specialize in doing that; colleges should concentrate on what they do well; 

efficiency and minimization of duplication. 

College specific metrics: in addition to college system metrics; colleges track info that is more 

specific to their college 

Finance and Funding: new category added; financial sustainability and growth; college funding 

model will link funding to achieving differentiation (stay tuned). 

Structure of SMAs: 

- Jobs, innovation, economic development 

- Teaching and learning 

- Student population 

- Program offerings 

- Student mobility (transfer) 

- Financial sustainability 

Teaching and Learning: 

- Student satisfaction 

- Graduation rates 

- Student retention 



- Work integrated learning 

- Elearning 

SMA Opportunities: 

- Standard and transparent information 

- Help you in your lobby efforts 

- Help you understand college directions 

Highlight the Column: Click on the cell > Control + Shift + Down  

Convert it into a graph: Highlight > Insert > Columns  

College Names in Chart: Right click on the chart > Select data > Edit > Highlight the Column of 

College Names > OK 

Find out Percentages of Indigenous Students: Right click on chart > Select Data > Add > 

Highlight Column 3 A.a. > MISSED A STEP (HOW TO CONVERT TO PERCENTAGES) 

SMA Renegotiations: 

- don’t provide enough info re: activites that support performance metrics 

- students and student leader not involved in planning, implementing, evaluating, SMAs 

- annual work plans are not published 

- need better data re: WIL (% of students in WIL programs, % of programs with WIL) 

Approached by the college about how to use special purpose funding? 

 



Developing a policy that would require your GMs to gather data about what we do at our SA.  

Each month your GM would be require to deliver data regarding operations at the Student 

Association. 

Principles: 

- One-stop shop for information 

- How money and resources are allocated 

- Useful to help you make decisions 

What do boards make decisions about? 

Advocacy: 

- Bus pass 

- Contracts 

- Facilities 

- Grade appeals 

- Health plan – domestic 

- Health plan – international 

- Parking pass 

- Residence 

Operations: 

- Ancillary fees 

- Events and activities 

- Financial overview 

- Policy 

- Programs and services 

- Staff 

What do we want more information about? 

- library usage 

- Athletics 

- financial transparency 

SA Operations Policy (to date): 

Advocacy: 

- Contracts 

- Grade Appeals 

- Health Plan – domestic 

Operations: 



- Ancillary Fees 

- Policy 

- Programs and Services 

Mapping your Events: 

Highlight the column > Insert column 

Right click > Select Data > Add Series > Highlight another column > OK > Right click > Change 

Chart Type > Combo 

Contact:  

John Horrox 

1-647-454-9951 

research@collegestudentalliance.ca 

CSA WOW Factor Presentations 

Conestoga College – The Cycle of a Student Concern (video) 

Northern College – Catching Positivity 

Niagara College – Promoting CSA  

Cambrian College – YUP (video) 

Confederation College – Fundraising  

Open Spaces – Bylaws & Policies 

Cameron Jones  

Having strong and thorough policies are such a benefit to any organization. A reference guide of 

what to do in certain situations. Policies will set you free. 

President’s Role: 

- Full time/part time status (credit limit with classes; hours per week) 

- Non-fee-paying-member running the corporation 

- Take classes while being full time president; pay the fee and not take classes; the fee 

association with the student association (membership fee) 

- President as a second-tier member (non-voting member) 

- Selected by the board; re-election from board for second term 

Write down why policies are changed; our views and rationale; new board can understand the 

perspective. 

Confidentiality policy in by-laws. 

Plenary 

Yellow Umbrella Project is moving to Yellow is for Hello. YUP will cost CSA nothing next year. 

mailto:research@collegestudentalliance.ca


Looking at a bank to possibly sponsor Leadership Scholarship. 

ACL to sponsor Point Bank. Will not have any input into how points are being collected. 

Amended Motion to revisit the voting structure of CSA carried. 

MayCon Options (no colleges bid): Kingston, Ottawa, Blue Mountain 

Member Choice: Ottawa  


